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Introduction to the Auditing and Reporting Module 
The Auditing and Reporting Module (ARM) captures the transactions passing through EFT and provides an 
interface in the administration interface where you can use preconfigured reports or create your own custom 
reports to query, filter, and view transaction data. Data is stored in a relational database and can be analyzed in 
real time. 

The ARM comes with a number of preconfigured reports to help you start analyzing data right away. The 
built-in reports were designed to respond to the most common data analysis requests. 

Auditing and Reporting Interface 
The Report tab of the administration interface is the interface for Auditing and Reporting. 

 
• When you click the Report tab in the left pane, the right pane displays the report. Using the controls 

in the right pane, you can view, edit, print, and save the report or create a new report. 
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• When you define a new report template, it appears in the Custom Reports node of the tree. 

• Refer to Generating a Report, Managing Reports, and Custom Reports for details of running, 
managing, and defining reports. 

• Refer to Descriptions of Preconfigured Reports for descriptions of the report templates in the 
Globalscape Reports node of the tree. 

Installing and Configuring Auditing and Reporting 
The topics below provide the procedures for installing and configuring the Auditing and Reporting module. 

Auditing and Reporting is normally installed and configured when you install EFT. If you did not install it when 
you installed EFT, you can run the installer again, choose Modify, and then select the Auditing and 
Reporting check box. (Leave the EFT and EFT Admin Interface check boxes selected; clearing the check 
boxes will uninstall them.) 

For the procedure for installing ARM using the EFT installer and for the system requirements, refer to 
“Installing EFT, Administrator, and Modules” in the EFT User Guide. 

• For EFT to connect to any database, the proper drivers need to be installed on the EFT computer. If 
the right client-side software (driver) is installed on the EFT computer, the Advanced Workflow 
Engine can make the database connection string to get to that database. 

• EFT uses Microsoft ActiveX Data Objects (ADO) 2.7 or later to handle database communication, 
which in turn should load the Oracle drivers to handle Oracle implementation details. How and what 
is connected largely depends upon the connection string. By default, if you do not supply the entire 
connection string in EFT, the Oracle connection string should look like: 

• Provider=OraOLEDB.Oracle.1; Data Source=(DESCRIPTION = 
(ADDRESS_LIST = (ADDRESS = (PROTOCOL = TCP)(HOST = {host value})(PORT = 
{port})))" 
(CONNECT_DATA =(SERVICE_NAME = {database name}))); 
Persist Security Info=true;PLSQLRSet=1;PwdChgDlg=0;User 
Id={username};Password={password}; 

Installation and configuration of the module consists of: 

1. Running the EFT installer. The Auditing and Reporting module is normally installed and configured 
when you install EFT. If you did not install it when you installed EFT, you can run the installer again 
and choose Modify. On the ARM page of the installer, click Configure Auditing and Reporting. 
(Follow the procedure in Installing EFT, Administrator, and Modules.) 

 

During installation, EFT needs full DB Owner access to the auditing database to set up the schema. 
During updates or upgrades, EFT needs full DB Owner access to update the schema. Once it is set up, 
EFT only needs to be able to read, write, and execute stored procedures. 

2. Activating the software with a serial number that includes ARM 

3. Enabling EFT to record data 
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How does EFT know which TCP/IP port it should use to connect to SQL Server? 

When the SQL Server browser service (installed with SQL Server) starts up, it searches the registry for any 
"named instances" of SQL Server and which TCP ports they're listening on. When a client wants to connect to 
a named instance, it asks the browser service (on UDP port 1434) on which TCP/IP port is that instance 
listening. This is how Microsoft implemented support for multiple instances of SQL Server on the same 
computer. The default instance listens on TCP port 1433. If you have a named instance, the TCP port is 
dynamically configured. 

This is standard SQL Server functionality and doesn't require special port syntax in the EFT connection string 
or host name. It's all abstracted by the API used, which looks at the host string and figures out whether you're 
trying to connect to a named instance or a default instance (by determining whether host\instance or just host 
was specified). 

The SQL Server TCP settings are stored in: 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Microsoft SQL 
Server\MSSQL10.<InstanceName>\MSSQLServer\SuperSocketNetLib\TCP\ 

Refer to the following Microsoft topics for more information: 

• For details of how to view/change the TCP information in the SQL Server Configuration Manager, 
refer to the following MSDN article: 
http://msdn.microsoft.com/en-us/library/ms177440%28SQL.90%29.aspx, "How to: Configure a 
Server to Listen on a Specific TCP Port (SQL Server Configuration Manager)." 

• http://support.microsoft.com/kb/287932, "Configure the Windows Firewall to Allow SQL Server 
Access" 

• http://msdn.microsoft.com/en-us/library/ms175483.aspx, "Connecting to SQL Server over the 
Internet" 

• http://msdn.microsoft.com/en-us/library/ms181087.aspx, "SQL Server Browser Service" 

EFT Database Utility 

A command line utility is included in the installer that is capable of performing various database-related tasks. 
This same utility is used by the EFT installer to handle upgrades of existing databases. Typically, all common 
database tasks are handled by the EFT installer. However, on occasion it may be useful to use the command-
line utility to verify the status of a database or perform an upgrade independent of the EFT installation 
process. 

The database utility (DBUtility.exe) is included as part of the core EFT installation. Once installed it is located 
in the "DBUtility" sub-directory of the EFT program files installation directory. Typically this will be 
C:\Program Files (x86)\Globalscape\EFT Enterprise\DBUtility. 

Requirements 

• The utility requires the .NET Framework 4 (Full version) 

http://msdn.microsoft.com/en-us/library/ms177440%28SQL.90%29.aspx
http://support.microsoft.com/kb/287932
http://msdn.microsoft.com/en-us/library/ms175483.aspx
http://msdn.microsoft.com/en-us/library/ms181087.aspx
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• When operating against an Oracle database, the utility requires the 32-bit version of the Oracle Data 
Access Components (ODAC) 

Capabilities 

The database utility is capable of performing the following tasks: 

• Check the version of the database to see if it is up to date. This may be used to see if an upgrade must 
be performed on a database before it is ready to be used by EFT. 

• Generate an SQL script that may be used to create a new database schema (tables, views, etc.) 
manually within an existing database. 

• Generate an SQL script that may be used to upgrade an existing database schema manually. 

• Analyze an existing database prior to performing an upgrade. The analysis will verify prerequisites, 
display information about the database, and display the SQL that will be used to upgrade the 
database. 

• Upgrade an existing database schema to the latest version. 

Logging 

The utility is capable of outputting various levels of information ranging from errors to debug/trace level 
information. 

By default, the utility will output errors, warnings, and informational messages to the command window. If the 
"-verbose" command line parameter is specified, the utility will also output more fined-grained debug/trace 
level messages to the command window. 

The utility may also optionally output to a log file as specified using the "-logfile" command line option. The 
output to the log file will include all levels of messages from errors to debug/trace level information. 

SQL Scripts 

The utility requires the presence of various SQL Scripts located in database-specific subdirectories to perform 
its actions. These subdirectories contain scripts such as: 

• create_* - scripts used for creating new, clean database schemas for use by the EFT application 

• Purge* - scripts that may be used for purging data from the database 

• *ODBC - scripts that may be used to create the necessary tables to use an ODBC data source for 
user authentication 

• upgrade_* - upgrade scripts for upgrading various versions of the database 

By default, the utility will look for the "SQL Server" and "Oracle" directories under its current working 
directory. During installation of the Database utility, these script directories will be created under the 
<InstallDir>\DBUtility directory, so the scripts will be available to the utility. 
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If the utility is unable to locate these subdirectories, it will also attempt to consult the registry for the EFT 
"AppData" path and then look for the subdirectories under that location. 

Additionally, the user may specify an alternate parent directory using the "-scripts" command line parameter. 

Usage 

The database utility is a command line utility and may be executed by opening a Windows Command Prompt 
and navigating to the "DBUtility" subdirectory of the EFT installation folder (e.g., C:\Program Files 
(x86)\Globalscape\EFT Enterprise\DBUtility) and running the command "DBUtility.exe." 

Help 

The utility includes built-in help documentation. Additionally, the utility will provide feedback on incorrect or 
missing command line parameters. 

The built-in help documentation for the utility may be accessed using the command: 
DBUtility.exe -help 

More detailed help for the various top-level actions may be accessed using the command: 
DBUtility.exe -help -action <Action ID> 

Where <Action ID> is one of: 

• CheckVersion - checks the version of the database to see if it is up to date 

• CreateScript - generates a SQL script that may be used to manually create a new database schema 

• UpgradePreview - used prior to upgrading a database. This action will generate and display useful 
pre-upgrade information as well as the actual SQL that will be used to upgrade the database 

• UpgradeSchema - upgrades the database, if needed 

• UpgradeScript - generates a script that may be used to manually upgrade a database 

Examples 

Example executions for each of the actions supported by the utility may be viewed in the command line help 
for each action. 

DBUtility Command Line Parameters 

The following section describes each of the command line parameters for the utility. Depending on the action 
performed, only a subset of the parameters will be applicable or required. 

For the command line parameters that accept a value, the value should be enclosed in double-quotes if the 
value contains spaces. For example, 

-logfile="C:\My Logs\MyLogFile.txt" 
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Parameter Definitions 

• -help 

o Description: Display help on the command line. Refer to the "Help" section above for 
additional information. 

• -logfile=<file> 

o Description: When specified the utility will log output of the execution to the specified log 
file. 

o Default: None 

o Example: 
o -logfile="C:\My Logs\MyLogFile.txt" 

• -optionsfile=<file> 

o Description: When specified the utility will load command line parameters from the file. The 
file should specify parameters in a "parameter=value" pair with one pair specified per line. 
Parameters specified on the command line override parameters specified in the file. 

o Default: None 

o Example: 
o -optionsfile="C:\My Scripts\MyOptionsFile.txt" 

• -scriptfile=<file> 

o Description: For actions that generate output SQL scripts this parameter defines the file to 
which the script should be written. 

o Default: None 

o Example: 
o -scriptfile="C:\My Scripts\MySQLScript.sql" 

• -errorfile=<file> 

o Description: When specified the utility will log terminal errors to the specified file. Mainly 
used for error handling when the utility is called by the EFT installer. 

o Default: None 

o Example: 
o -errorfile="C:\My Scripts\MyErrorFile.txt" 

• - resultfile=<file> 

o Description: When specified the utility will output result status codes for the execution to 
the file. Mainly used for state handling when the utility is called by the EFT installer. 
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o Default: None 

o Example: 
o =resultfile="C:\My Scripts\MyResultFile.txt" 

• -pause 

o Description: When specified the utility will pause at the end of the execution. Useful when 
executing the utility through a shortcut to keep the console window from closing before the 
user has a chance to review the results. 

o Default: None 

• -verbose 

o Description: When specified the utility will output additional debug level logging. 

o Default: None 

• -action=<id> 

o Description: Specifies the overall action to be performed by the utility. 

o Valid values: 

 CheckVersion - checks the version of the database to see if it is up to date 

 CreateScript - generates a SQL script that may be used to manually create a new 
database schema 

 UpgradePreview - used prior to upgrading a database. This action will generate and 
display useful pre-upgrade information as well as the actual SQL that will be used to 
upgrade the database 

 UpgradeSchema - upgrades the database, if needed 

 UpgradeScript - generates a script that may be used to manually upgrade a 
database 

o Default: None 

o Example: 
o -action=UpgradeSchema 

• -type=<type> 

o Description: The dialect of the database. 

o Valid values: 

 SQLServer - a SQL Server/SQL Server Express database 

 Oracle - an Oracle database 

o Default: None 



12 
 

o Example: 
o -type=SQLServer 

• -server=<server> 

o Description: The database server host or IP address 

o Default: None 

o Example: 
o -server="Jupiter" 

• -port=<port> 

o Description: The listener port for the database on the database server/host. 

o Default: None 

o Example: 
o -port=1433 

• -instance=<instance> 

o Description: The database server instance name. 

o Default: None 

o Example: 
o -instance="MSSQLSERVER" 

• -database=<database> 

o Description: The name of the database. 

o Default: None 

o Example: 
o -database="GLOBALSCAPE" 

• -timeout=<timeout> 

o Description: The timeout, in seconds, to continue trying to connect to the database. A value 
of 0 causes the utility to wait indefinitely and should be used with caution. 

o Default: 30 seconds 

o Example: 
o -timeout=5 

• -auth=<auth> 

o Description: The type of authentication to use when connecting to a SQL Server database. 

o Valid values: 



13 

 SQLServer - Use SQL Server authentication which requires specification of the 
username and password. 

 Windows - Use Windows authentication which will use the currently logged in user 
account. 

o Default: None 

o Example: 
o -auth=SQLServer 

• -user=<user> 

o Description: The login name to use when connecting to the database. 

o Default: None 

o Example: 
o -user="eftdbuser" 

• -pass=<pass> 

o Description: The password to use when connecting to the database. 

o Default: None 

o Example: 
o -pass=“3qym9NCebHDJ” 

• -scripts=<dir> 

o Description: Parent directory containing the SQL Server and Oracle SQL Scripts 
subdirectories. Refer to the "SQL Scripts" section above for additional information. 

o Default: Refer to the "SQL Scripts" section above for additional information. 

o Example: 
o -scripts="C:\ProgramData\Globalscape\EFT Server Enterprise" 

Advanced Parameter Definitions 

The following parameters are typically reserved for use by the EFT installer and will normally not be useful to 
end users. However, they are documented here for completeness. 

• -conn=<connection string> 

o Description: When specified this string will be used as the full connection string to the 
database rather than constructing the string based on the distinct parts. 

o Default: None 

o Example: 
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o -conn="Data 
Source=(DESCRIPTION=(ADDRESS_LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=mth-
oracle)(PORT=1521)))(CONNECT_DATA=(SERVICE_NAME=orastart)));Persist 
Security Info=true;User Id=eftdbuser;Password=3qym9NCebHDJ" 

• -app=<application name> 

o Description: The application name to present to the database for use when identifying 
connections. 

o Default: None 

o Example: 
o -app="EFT Database Utility" 

• -installerdir=<directory> 

o Description: The directory containing the EFT Installer. May be used during some upgrades 
for accessing or storing additional files. 

o Default: None 

o Example: 
o -installerdir="C:\Users\Administrator\AppData\Local\Temp\nsdB57C.tmp" 

• -installationdir=<directory> 

o Description: The directory where EFT is installed or will be installed. May be used during 
some upgrades for accessing or storing additional files. 

o Default: None 

o Example: 
o -installationdir="C:\Program Files (x86)\Globalscape\EFT Server 

Enterprise" 

• -appdatadir=<dir> 

o Description: The directory that will be used for the EFT application data. May be used during 
some upgrades for accessing or storing additional files. 

o Default: None 

o Example: 
o -appdatadir="C:\ProgramData\Globalscape\EFT Server Enterprise" 

• -backupdir=<dir> 

o Description: The directory in which to store backup data. May be used during some upgrades. 

o Default: None 

o Example: 
o -backupdir="C:\ProgramData\Globalscape\EFT Server Enterprise\Backup" 
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Database User Account Privileges 

The database user account used by EFT must have certain privileges within the database for the application to 
function correctly. Additionally, a different set of privileges are needed for Installation, Upgrade, and Runtime, 
as described below. 

Installation—When creating a new database, the EFT installer is capable of creating the database user 
account for you. Alternatively, you may create the database user account ahead of time. Either way, the EFT 
database user account must have certain privileges during the creation process. Once the creation process is 
complete, the privileges may be reduced to those necessary for runtime operation. (Refer to Runtime below.) 
The following privileges, or their equivalents, are required during the creation process: 

• SQL Server—The database user account must have the "db_owner" database role membership. 

• Oracle—The database user account must have the following privileges: 

• CREATE SESSION 

• CREATE TABLE 

• CREATE TRIGGER 

• CREATE SEQUENCE 

• CREATE PROCEDURE 

• CREATE VIEW 

Upgrade—When upgrading the ARM database, either through the EFT Installer or the Database Utility 
(DBUtility.exe), you should use the EFT database user account to connect to the database to perform the 
upgrade. The upgrade process may temporarily require that additional privileges be temporarily given to the 
EFT database user account. The actual set of privileges depends on the version of the database schema being 
upgraded. Before upgrading the database, the EFT Installer will perform an analysis of the database. 
Additionally, the "UpgradePreview" action may be used with the Database Utility to perform the analysis. Part 
of this analysis will verify that the database user account possesses the necessary privileges to perform the 
upgrade. The analysis results will display any privileges that the account is lacking. You will need to grant the 
appropriate privileges to the account temporarily before proceeding with the upgrade. These privileges 
may be revoked once the upgrade process is complete. Refer to the Runtime section below for the privileges 
required during subsequent operation of EFT. To minimize the chance of encountering missing privileges, you 
should grant the privileges described in Installation, above, before performing the upgrade preview analysis. 

Runtime—During normal operations, the EFT only manipulates the data within the database while auditing, 
and so requires less powerful privileges. EFT does not modify the database schema during normal operation. If 
you want to lock down the EFT database user accounts during normal operation, ensure that the following 
minimal privileges, or their equivalents, are granted to the account: 

• SQL Server—When operating against SQL Server, the EFT database user account only needs to be 
able to read data, write data, and execute stored procedures. The following permissions are required 
during normal operation: 
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• CONNECT 

• DELETE 

• EXECUTE 

• INSERT 

• SELECT 

• UPDATE 

• Oracle—During normal operation, the EFT database operates only within its own schema. 
Additionally, it has no need to create objects during runtime. Only the following privilege is required 
during normal operations: 

• CREATE SESSION 

Activating the Auditing and Reporting Module 

The Auditing and Reporting Module (ARM) is an add-on to EFT that comes with a unique activation serial 
number. 

• If you have purchased EFT with ARM and have your serial number, follow the normal activation 
process. 

• If you are upgrading, follow the upgrade process. 

Upgrading the EFT Database 

This introduction describes in general how an EFT database upgrade works. 

A Database Utility (DBUtility.exe) is used to upgrade the database, when applicable. You have the option of 
either upgrading the database during the upgrade process within the EFT Installer or choose to upgrade the 
database "out of band" later using the Database Utility. Because the EFT installer uses the same Database 
Utility internally to perform the upgrade, the methods are synonymous. 

As part of this new approach to upgrading the ARM database, the database schema maintains an independent 
version number. This version is used to determine if the database schema and data require an upgrade across 
various releases of the EFT application. This version number is maintained in a new table called 
"TBL_SCHEMA_VERSION." This new table is created as part of the initial ARM upgrade process when 
upgrading EFT. 

During the upgrade, you will be prompted to provide the user credentials that should be used when 
connecting to the database. You must provide the credentials for the EFT database user account, as 
opposed to the super-user accounts such as "sa" or "sys", because the upgrade process assumes it is 
operating as the database account that owns the schema to be upgraded. (Refer to Database User Account 
Privileges > Upgrade for information on the required database user account privileges necessary to 
successfully upgrade.) 

https://kb.globalscape.com/KnowledgebaseArticle11194.aspx
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When upgrading from within the EFT installation process, the installer will analyze the database prior to 
performing the actual upgrade. The results of this analysis are displayed in an upgrade preview page of the 
installer. Administrators are urged to read the results carefully prior to continuing with the upgrade. (EFT's 
upgrader does not check the database for fragmentation.) 

The analysis step will determine whether the database requires an upgrade by examining the version number in 
the new version table. Across many builds and releases of the EFT application, the ARM database may not 
require any changes. As such, the version number for the database may not change as often as the EFT 
version. If the database does not require an upgrade, then the installer will state this and essentially skip the 
ARM upgrade process. 

As with the database upgrade, the database analysis process used in the EFT installer is actually performed by 
the Database Utility and is equivalent to running the utility with the "-action=PreviewUpgrade" command line 
option. In addition to checking the database version number, the installer/utility will also check for various 
prerequisites needed to perform the upgrade. Prerequisites that have been met will be displayed with a 
"PASS" status. Any prerequisites that have not been met will be displayed with a "FAIL" or "WARN" status. 
These issues should be researched and rectified prior to proceeding with the upgrade. 

Recommendations are provided along with any failed prerequisites suggesting how to resolve the issue. After 
remedying any errors, you can run the analysis again by clicking Reanalyze. 

The analysis will also display information about the database such as the approximate size of the user data as 
well as the age of the user data within the database. Additionally, the SQL script that will subsequently be used 
to perform the actual upgrade will be displayed. 

You may decide to upgrade the database later. If so, you can retain the upgrade script by clicking View to 
open the database analysis results in a text editor and then save to a file of your choosing. 

Alternatively, you can run the EFT installer in maintenance mode or run the Database Utility using the "-
action=UpgradeSchema" option to upgrade the database another time. 

User Account Permission/Privilege Requirements 

When upgrading the ARM Database, either through the EFT Installer or the Database Utility, you should use 
the EFT Database user account to connect to the database to perform the upgrade. This is as opposed to 
using one of the more privileged system accounts such as the "sa" account on SQL Server or the "sys" or 
"system" accounts on Oracle. 

For additional information related to database user account privileges refer to Database User Account 
Privileges. 

SQL Server 

The user account used to upgrade the database should have the "db_owner" privilege. This is the default for the 
user account created for, and used by, the EFT. As such, no action is required on your part prior to upgrading. 
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Oracle 

The ARM module makes use of database views. In previous releases, the database user account created for 
use by the EFT was not granted the ability to create views. As such, prior to upgrading an Oracle ARM 
database, you must grant this privilege to the EFT database user account manually. This is done by granting 
the "CREATE VIEW" privilege to the account using a more privileged account such as the "sys" or "system" 
account. 

One method of granting the privilege is to connect to the database using the Oracle command line "SQL 
Plus" utility. On the computer where Oracle is installed, launch the SQL Plus utility: 

• Click the SQL Plus Start menu shortcut (e.g., Start Menu > All Programs > Oracle - 
OraDb11g_home1 > Application Development > SQL Plus) 

• If the utility is available on the system path, then open a Windows command prompt (e.g., Start > 
Run > cmd.exe), type sqlplus at the command prompt, and then press ENTER. 

Once SQL Plus has started, you will be prompted for login credentials. Connect using a privileged account 
such as "sys" or "system". Be aware that when connecting as the "sys" account you must provide the "as 
sysdba" option; for example: 

sys as sysdba 

 
Complete the login process by providing the password. 

Use the following command to grant the "CREATE VIEW" privilege to the EFT database user account: 
GRANT CREATE VIEW TO <User>; 

Where <User> is the name of the EFT database user account. For example: 
GRANT CREATE VIEW TO EFTDBUSER; 
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Exit the SQL Plus tool by typing Exit and pressing ENTER. 

Time Requirements 

The time it takes to perform the upgrade depends both on the size of the database and the performance 
characteristics of the computer on which the database resides. 

Our internal testing has shown that the database upgrade can take as little as 15 minutes for a moderately 
sized database of 5GB, up to 3 hours or longer for larger databases of 30GB or more. Because the time it 
takes to perform the upgrade is greatly dependent on CPU and Disk I/O speed, it is difficult to provide an 
exact time for any given situation. 

For additional information related to upgrading large databases please refer to Upgrading Large Databases. 

Refer to Upgrade Paths below for a discussion of the available upgrade paths that may be used to minimize 
down time. 

Disk Space Requirements 

The size of the database will grow as part of the upgrade because of changes in the data types used for storing 
character-based data. 

Our internal testing indicates that, on average, the size of user data in the database will increase by 
approximately 31% as part of the upgrade process. For example, if your database consumes 10GB before 
upgrading, then it will use approximately 13GB after upgrading. 

If disk space is limited, you should consider purging older data from the database prior to upgrading. For 
information on purging data from the ARM database, refer to Purging Data from the Database. 

For additional information related to upgrading large databases, refer to Upgrading Large Databases. 

SQL Server Considerations 

If you have limited disk space and are using SQL Server, it may be possible to reduce the size of the database 
prior to proceeding with the upgrade. This may be accomplished by "shrinking" the database, which will reclaim 
unused space. 
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For information and considerations on shrinking a SQL Server database, please refer to the Shrink a Database 
topic on the Microsoft Developer Network site. 

During the upgrade process, the increase in size of the user data will be reflected by an increase in the size of 
the database's MDF file by approximately 31%. 

Additionally, the database transaction log file, the LDF file, may temporarily grow in size. In testing, the LDF 
file typically increased to between 1% and 3% of the starting size of the corresponding MDF file. For example, 
if your MDF file is 10GB in size, then the LDF file could be expected to grow temporarily to approximately 
300 MB in size. 

Oracle Considerations 

When upgrading Oracle databases you must ensure that not only is the appropriate amount of disk space 
available, but that the USERS tablespace is capable of growing to accommodate the additional storage 
requirements. You may consider allowing the USERS tablespace data files to auto extend during the upgrade 
process. Additionally it may be necessary or desirable to create additional data files for use with the USERS 
tablespace. 

Upgrade Paths 

Depending on the size of the ARM database and the time constraints on performing the upgrade of EFT, you 
may choose to consider alternate methods of upgrading the ARM database. Described below are pros and 
cons of two alternate methods of upgrading the database, when each method is appropriate, and how to 
perform the upgrade using each method. 

Method 1: During the EFT upgrade 

This is the typical method of upgrading the ARM database. When running the EFT installer, you can 
upgrade the ARM database as part of the full upgrade process. 

Pros 

• Simplest method, requiring minimal manual steps 

Cons 

• The EFT will be unavailable for the time it takes to perform the entire upgrade 

Appropriate When 

• The ARM database is relatively small or the computer running the database is sufficiently 
powerful 

• The ARM database is large, but a few hours of downtime is acceptable 

How to Perform 

• When upgrading using the EFT installer, on the EFT Enterprise Auditing and Reporting 
database configuration page of the wizard, click Configure Auditing and Reporting and 
proceed accordingly. 

http://msdn.microsoft.com/en-us/library/ms189035.aspx
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Method 2: Out of band 

With this method, EFT may be upgraded independent of the ARM Database. Specifically, you would 
upgrade EFT using the EFT installer application, but choose to skip upgrading the ARM database at 
that time. Once the EFT application has been upgraded, it may be restarted and will thus be available 
to service end users. During the time that the ARM Database has not yet been upgraded, the EFT 
application can temporarily store audit information to disk. 

You can then upgrade the ARM database using the Database Utility. Once the upgrade has 
completed, the EFT will then be able to reconnect to the database as normal. 

Pros 

• Allows for minimal downtime of the main EFT facilities 

Cons 

• EFT Reporting capabilities will be temporarily unavailable 

• Requires additional steps to perform the upgrade 

Appropriate When 

• Upgrading very large database and the necessary downtime of the main EFT facilities is 
unacceptable 

How to Perform 

• Prior to starting the upgrade process, configure the EFT application to audit to a folder while 
disconnected from the database. Refer to Audit Database Settings for information about this 
functionality. 

• Upgrade the EFT application using the EFT installer. On the EFT Enterprise Auditing and 
Reporting database configuration page of the installer, click Skip Auditing and Reporting 
configuration and proceed accordingly. 

• After EFT has been upgraded, restart the EFT service. 

• Upgrade the ARM database using the Database Utility. 

o First, perform a preview upgrade using the "-action=UpgradePreview" option of the 
utility. This will verify that the appropriate requirements for upgrading the database 
have been met. 

o After the requirements have been verified, use the "-action=UpgradeSchema" 
option to perform the actual upgrade. Optionally you may instead generate an 
upgrade script using the "-action=UpgradeScript" option and manually upgrade the 
database using vendor tools such as SQL Server Development Studio or SQL Plus. 

o Refer to EFT Database Utility for additional information. 
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ARM Upgrade Checklist 

SQL Server 

o Ensure a current backup of the database is available 

o If necessary/desired, purge older data from the database 

o Ensure the necessary disk space is available to perform the upgrade 

o Remove any custom schema modifications made to the database 

o Follow the desired upgrade method 

o Recreate any custom schema modifications 

Oracle 

o Ensure a current backup of the database is available 

o If necessary/desired, purge older data from the database 

o Ensure the necessary disk space is available to perform the upgrade 

o Ensure the USERS tablespace and associated data files are configured to allow for the necessary data 
growth 

o Remove any custom schema modifications made to the database 

o Grant the "CREATE VIEW" privilege to the EFT database user account 

o Follow the desired upgrade method 

o Recreate any custom schema modifications 

Upgrading Large Databases 

The majority of the modifications performed on the ARM database when upgraded take only minutes to 
complete. Occasionally, more modifications are needed when upgrading the database schema. These 
upgrades may take a long time, especially when they require modifications to the data stored within the 
database. As such, the time it takes to perform the upgrade may increase with the size of the database. 
Depending on the size of the database, such upgrades take hours instead of minutes. 

The database upgrade preview process includes the age of the oldest data in the database as well as a rough 
estimate of the database size. Administrators should use this data to assess the current state of the database 
when deciding how and when to proceed with the database upgrade. 

Administrators of large databases should consider the following options to ensure a smooth upgrade process: 

• Administrators should consider purging older data from the database prior to upgrading. (Refer to 
Purging Data from the Database for details.) 

• The database should be backed up prior to any upgrade to allow for quick recovery in case of errors. 
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• Administrators should consider making a copy of the ARM database and performing a test upgrade of 
the database. The script necessary to perform the test upgrade may be obtained by proceeding 
through the EFT Installer's upgrade process and choosing to upgrade the ARM Database. When 
prompted for the database credentials, specify the test database credentials. On the Upgrade 
Preview page of the installer, click View, save a copy of the upgrade script, and then cancel the EFT 
installer. You may now use the SQL script to upgrade the database manually. Alternatively, you can 
install a clean copy of EFT on another computer and use the Database Utility (DBUtility.exe) to 
perform the test upgrade. 

• Administrators should consider upgrading the database out-of-band from upgrading the EFT 
installation. This may be done by skipping the ARM database upgrade in the EFT Installer when 
performing the initial EFT upgrade. The updated version of the EFT will temporarily audit database 
transactions to disk until the ARM database has been upgraded. 

• To perform an out-of-band upgrade of ARM 

1. If desired, prior to upgrading the EFT, enable the ARM audit-to-folder feature. 

2. Use the installer to upgrade the EFT, but skip the ARM upgrade process, then do one of the 
following: 

• Rerun the installer in maintenance mode later to upgrade the ARM database. 

• Use the Database Utility (DBUtility.exe) to perform the upgrade. 

• Manually upgrade using the SQL scripts generated by DBUtility.exe. 

3. After the ARM database has been upgraded, click Reconnect in the EFT administration 
interface, on the Server's Logs tab to instruct EFT to connect to the upgraded database. EFT 
will then import any database transactions that were audited to disk in the interim. 

Manually Creating the ARM Database in SQL Server 

This procedure should only be used if you have not already created the ARM database using the EFT installer. 
All tables will be created in the schema regardless of which features and/or modules are actually in use. 

The following instructions use the SQL Server Management Studio application from Microsoft. Optionally, 
users may prefer to use command line tools such as oSQL to create the database. The oSQL utility allows you 
to execute Transact-SQL statements, system procedures, and scripts for creating and maintaining the 
database. For additional information on the oSQL utility, including common script samples, refer to osql 
Utility on microsoft.com. 

First you will create the database, then create the database user account, create the schema, configure EFT 
to connect to the database, and then test the connection. 

http://msdn.microsoft.com/en-us/library/aa214012(SQL.80).aspx
http://msdn.microsoft.com/en-us/library/aa214012(SQL.80).aspx
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Create the Database 

To create the database 

1. Using the SQL Server Management Studio application, connect to the SQL Server instance using an 
account that has the privileges necessary to create user accounts and databases. Typically the "sa" 
account will suffice. 

2. In the left pane, right-click Databases, then click New Database. 

 
3. The New Database dialog box appears. Name the database eftdb. (You can use a different database 

name, but be sure to use the name you chose throughout this procedure.) 

4. In the Database files table, change the Initial size value to 10 MB for the eftdb logical name (first 
row). Leave the eftdb_log row as is. The dialog box should resemble the following screen shot: 

 



25 

5. Click OK to finalize creation of the database. 

Create the Database User Account 

 

During installation, EFT needs full DB Owner access to the auditing database to set up the schema. During 
updates or upgrades, EFT needs full DB Owner access to update the schema. Once it is set up, EFT only needs to 
be able to read, write, and execute stored procedures. For more information on the required database privileges 
please refer to Database User Account Privileges. 

To create the database user account 

1. Using the SQL Server Management Studio application, connect to the SQL Server instance using an 
account that has the privilege to create user accounts and databases. Typically the "sa" account will 
suffice. 

2. In the left hand pane, expand the Security node, right-click Logins, and then click New Login. The 
New Login dialog box appears. 

 
3. Create a new user called eftuser and then click SQL Server Authentication. (You can use a 

different user name, but be sure to use the name you chose throughout the procedure.) 

 

If SQL Server Authentication is not available as a choice, verify that the SQL Server has been configured 
to support mixed mode. 

4. In the Password and Confirm password boxes, provide a complex password consisting of an 
alphanumeric and symbol mix of at least 8 characters. 

5. Ensure the Enforce Password Policy check box is selected. 

6. Ensure the Enforce password expiration check box is not selected. (Optionally, you can enable this 
setting, but be aware that the eftuser account password will need to be changed periodically to 
prevent expiration.) 

7. Ensure the User must change password at next login check box is not selected. 

8. Set the Default database to the eftdb database created earlier. 

9. In Default language, click the list to select your language or leave it set to the <default> setting. The 
dialog box should resemble the following screen shot: 
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10. Select the User Mapping node in the left pane. 

11. In the Users mapped to this login table, locate the entry for the eftdb database created earlier. 

12. Select the check box in the Map column for the eftdb row and set the Default Schema to dbo. 

13. While the eftdb row is selected, in the Database role membership for table, select the dbo_owner 
check box. The dialog box should now resemble the following screen shot: 
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14. Click OK to finalize the user creation. 

Create the Schema 

During installation of the EFT, the installer will place a set of database creation SQL scripts in the 
GlobalSCAPE\EFT Server Enterprise\SQL Server subfolder of the system Program Data folder. 
(Typically, C:\ProgramData\GlobalSCAPE\EFT Server Enterprise\SQL Server.)  The database creation 
scripts use the "create_#_" filename prefix. The # in the filename represents the order in which each script 
must be executed. 

 
You will use these scripts to create the schema using the procedure below. 

To create the schema 

1. Using the SQL Server Management Studio application, connect to the SQL Server instance using an 
account that has the privilege to create user accounts and databases. Typically the "sa" account will 
suffice. 
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2. In the left pane, expand the Databases node, right-click on the eftdb node, and click New Query. A 
blank screen appears in the right pane in which you can type in a SQL query. 

3. Execute each creation script in the specified order by copying/pasting the script file contents into the 
left pane and clicking Execute. A message appears each time you click Execute indicating whether 
the query was able to complete successfully. 

4. In the left pane, expand Databases, then eftdb, then Tables. Verify that the database has populated 
correctly. (The tables defined in the script should have been created.) 

Configure EFT 

To configure EFT to connect to the newly created database 

• Refer to Audit Database Settings. 

Test Your Connection 

To test the connection 

1. Create a test connection with your FTP client to EFT and upload and download a few files. 

2. In SQL Server Management Studio select the dbo.tbl_ProtocolCommands table under the eftdb 
database icon. It should return several rows with the commands issued by your client from the test 
connection. 

3. You can now pull reports directly from EFT against data audited to SQL Server. 

 

If you are running the administration interface, you must have an entry in that system's DNS for the name of the 
SQL Server, otherwise the administration interface will not be able to connect to the SQL Server when attempting 
to pull reports. 

Manually Creating the ARM Database in Oracle 

This procedure should only be used if you have not already created the ARM database using the EFT 
installer. 

All tables will be created in the schema regardless of which features and/or modules are actually in use. 

The following instructions assume you have already installed the Oracle database software and that an Oracle 
database is available. These instructions will make us of the Oracle SQLPlus command line utility to execute 
SQL against the Oracle database. Optionally, users may use an alternate utility of their preference. 

 

If you are running the administration interface, you must have an entry in that system's DNS for the name of the 
Oracle database computer, otherwise the administration interface will not be able to connect to the database when 
attempting to pull reports. 
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Create the Database User Account 

During installation and upgrade, EFT needs creation privileges within the database. Once it is set up, EFT only 
needs to be able to read, write, and execute stored procedures. For the specific set of privileges required, 
please refer to Database User Account Privileges. 

To create the database user account 

1. Using SQLPlus connect to the Oracle database using an account that has the privileges necessary to 
create user accounts and grant privileges. Typically the "sys" or "system" account will suffice. Note 
that when connecting as the "sys" account you will typically need to specify the "as sysdba" option. 

 
2. Create the database user account by executing the following statement in SQLPlus, replacing 

<username> with the desired database user account name, such as eftuser, and 
<password> with the desired password. 

CREATE USER <username> 
IDENTIFIED BY <password> 
DEFAULT TABLESPACE USERS 
QUOTA UNLIMITED ON USERS 
TEMPORARY TABLESPACE temp QUOTA 5M ON system 
/ 

 For example: 
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3. Grant the necessary privileges to the database user account by executing the following statements in 
SQLPlus, replacing <username> with the username of the account you just created, such as eftuser. 

GRANT CREATE SESSION TO <username> 
/ 
GRANT CREATE TABLE TO <username> 
/ 
GRANT CREATE TRIGGER TO <username> 
/ 
GRANT CREATE SEQUENCE TO <username> 
/ 
GRANT CREATE PROCEDURE TO <username> 
/ 
GRANT CREATE VIEW TO <username> 
/ 

For example: 

 
4. To exit SQLPlus, type exit and press ENTER. 

Create the Database Objects 

During installation of the EFT the installer will place a set of database creation SQL scripts in the 
GlobalSCAPE\EFT Server Enterprise\Oracle subfolder of the system's Program Data folder. (Typically, 
C:\ProgramData\GlobalSCAPE\EFT Server Enterprise\Oracle.) 

The database creation scripts use the "create_#_" filename prefix. The # in the filename represents the order in 
which each script must be executed. 
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To create the database objects 

1. Using SQLPlus connect to the Oracle database using the EFT database user account created above.  

 
2. In SQLPlus, execute each database creation SQL Script in the correct order using the command, 

replacing <Script File Path> with the full path and filename of the script. 
@"<Script File Path>" 

For example: 

 
3. Once you have executed all of the creation scripts you may exit SQLPlus by typing exit and 

pressing ENTER. 
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Configure EFT 

To configure EFT to connect to the newly created database 

• Refer to Audit Database Settings. 

Test Your Connection 

To test your connection 

1. Create a test connection with your FTP client to EFT and upload and download a few files. 

2. Using SQLPlus, connect to the Oracle database using the EFT database user account. For example: 

 
3. Retrieve the number of rows in the TBL_PROTOCOLCOMMANDS table by executing the following 

statement in SQLPlus: 
SELECT COUNT(*) FROM TBL_PROTOCOLCOMMANDS; 

For example: 
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The above query should return a count of more than 0. 

4. To exit SQLPlus, type exit and press ENTER. 

5. You can now pull reports directly from EFT against data audited to Oracle. 

ARM Schema 

The ARM schema tables and ARM versions are described in Knowledgebase article #11031, 

(Refer to Result IDs for a description of the Result ID columns that appear in some reports.) 

ARM Database Schema Change Tracking 

The ARM database schema may undergo many changes between versions. Each ARM schema version is 
described in Knowledgebase article #11031, from newest to oldest. The database version number appears in 
the installer during upgrade, and you can see what the changes were.  

Audit Database Settings 
When you run the EFT Server Setup wizard, you are offered the opportunity to enable auditing and reporting 
and configure the connection information. If you chose to do that later or if you want to edit the database 
information, you can do so on the Logs tab in the Audit Database Settings area. 

To enable and configure auditing and reporting 

1. In the administration interface, connect to 
EFT and click the Server tab. 

2. On the Server tab, click the Server node you 
want to configure. 

3. In the right pane, click the Logs tab. 

4. In the Audit Database Settings area, select 
the Enable Auditing and Reporting check 
box to enable communication with the 
database; clear the check box to disable 
auditing and reporting. 

5. In the Database type area, select SQL 
Server or Oracle. (Oracle is available in EFT 
Enterprise only.) 

6. In the Database host address[\Instance 
Name] box, specify the host or database 
instance name of the database to which you 
want EFT to connect, or provide a DSN or 
DSN-less connection string.  

https://kb.globalscape.com/KnowledgebaseArticle11031.aspx
https://kb.globalscape.com/KnowledgebaseArticle11031.aspx


34 
 

7. In the Database Name box, provide the name of the database or leave the box empty if you provided 
a connection string in the Database host address[\Instance Name] box. 

8. For SQL Server databases, in the Authentication box, specify whether the database is to use 
Windows Authentication or SQL Server Authentication. If the database is using Windows 
Authentication, the EFT Insight server service needs to run as a Windows user with permission to 
access the database. 

9. In the Database username and Password boxes, provide the username and password needed to 
connect to the database or leave the box empty if you provided a connection string in the Database 
host address[\Instance Name] box or if you are using Windows Authentication. 

10. Next to Diagnostic Logging Settings, click Configure. 

 
11. In the When a database error occurs area, specify whether you want to audit database errors to a 

folder: 

• If you do want to audit errors, or to stop it temporarily, click Stop auditing. 

• To Audit to folder, click the option, then specify the path to the folder in the box. 

12. To automatically try to reconnect after an error occurs, select the Attempt to reconnect every 
check box and specify the frequency in seconds, from once every 7 seconds to once every 86,400 
seconds (once per day). 

13. In the E-mail notification area, select the On disconnect check box and/or the On reconnect 
check box, and then in Recipient list specify one or more e-mail addresses that you want to receive 
error notifications in case of database failure. Multiple e-mail addresses must be separated by 
semicolons (;). When auditing is enabled, this e-mail is sent any time that EFT cannot reach the 
database. 

14. If you make any changes to the database audit settings, click Apply to save the changes on EFT. 

15. To verify the connection information, click Test Connection. The status of the database connection 
appears above the Reconnect button. If the database is not connected, click Reconnect to 
reconnect to the database. 
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• Test Connection - EFT attempts a connection using the supplied parameters without 
applying the changes. 

• Reconnect - EFT applies the settings (a prompt appears if you made changes and did not 
click Apply) and attempts to connect to ARM with the new settings. 

Auditing Database Recovery 

If the auditing database has failed and EFT has been disconnected from the database for a while, you can 
prevent a loss of data by automatically saving auditing data to a text file when EFT is disconnected from the 
database. If EFT is configured to save auditing information to a text file, before reconnecting EFT to the 
database, repair the database, and then insert the data from the text file into the database. Then you can 
reconnect EFT to the database as described below. 

 

The SQL statements logged in the text file must be loaded into the database before any reports are run. 

If EFT is disconnected from the database and is configured to save auditing information to the log file, 
do the following: 

1. Solve the connection problem. 

2. Repair the database, and insert the data from the text file into the database. Be sure to insert the data 
only once, otherwise the auditing data will be corrupted. 

3. In the administration interface, connect to EFT and click the Server tab. 

4. On the Server tab, click the Server that you want to configure. 

5. In the right pane, click the Logs tab and review the database connection information. 

6. If you make any changes to the database host address, instance name, database name, etc., click 
Apply to apply these changes to EFT.) 

7. Click Test Connection to test the status of the database connection. 

8. The Connection status area indicates whether EFT is communicating with the database. To 
reconnect to the database, click Reconnect. 

How EFT Handles SQL Data 

EFT truncates data values within each audited SQL transaction to ensure the data value fits within the 
corresponding database field. 

The special characters (as defined by the SQL interpreter) within each data value of an audit SQL event are 
escaped to ensure the data value is stored and retrieved properly from the database. The following special 
characters are escaped by EFT during generation of SQL statements prior to submission to the database 
engine: 

• Single quote - % 

• Open brace - [ 

• Percent - % 

• Underscore - _ 
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Auditing Event Rule Actions 

Actions are audited to the Auditing and Reporting Module (ARM) database. For all Event Actions, the 
following items are audited: 

• Time stamp 

• Site Name 

• Event Name 

• Action Types such as move, copy, OpenPGP, and send e-mail. 

• Action Parameters* - These are runtime values passed to the Action, not the replacement variables. 

• Failed Action Flag - This is captured if this Action is the result of a FAILURE sequence on a prior 
Action. 

• Action Result Code 

• Result 

*For Advanced Workflow Actions, this is the path to the temporary file associated with the Workflow 
that was executed. This file contains more detailed debug logging if enabled for that particular 
workflow. 

Auditing Administrator Changes to the ARM Database 

(Requires Advanced Security Module in addition to ARM) Administrators often need to know when and 
what changes were made to EFT and who made them. The Administrator Actions Log report provides 
information about administrator changes. 

EFT logs the following changes made to EFT to the ARM database: 

• The Date the action occurred, in MM/DD/YYYY HH:MM:SS format. 

• The affected feature or Function. (Refer to Functions Audited below.) 

• The type of Action (created, added, removed, modified, enabled, disabled, started, and stopped). 

• The Affected Area (Server, Site, Settings Template, User Account, Event Rule, Command, Group, 
VFS, Report). 

• The name of the affected object, Affected Name (Server Name, Site Name, Settings Template 
Name, User or Admin Account Name, Event Rule Name, Command Name, Group Name, Folder 
Name, Report Name). 

• The name of the administrator that made the change, Change Originator. 

The data in the preconfigured report is arranged in columns, Date, Function, Action, Affected Area, 
Affected Name, and Change Originator, grouped by Site name, and sorted in reverse chronological order 
(newest change at the top). 



37 

 
Functions Audited 

When the following functions are created, added, removed, modified, enabled, disabled, started, or stopped, 
the action is logged to the database. Many possible actions are grouped together. For example, modifying SSL 
cipher selection, changing SSL clear command channel values, or modifying SSL connection string all fall 
under "SSL settings." Also, intermediate states are not audited (e.g., a toggle was checked, but later 
unchecked, rendering the transaction moot). Instead, only committed states are captured (once the 
administrator applies changes). 

• SFTP protocol 

• SFTP settings 

• SFTP key 

• SFTP authentication 
settings 

• SSL protocol 

• SSL settings 

• SSL require client 
certificate 

• SSL certificate 

• SSL authentication 
settings 

• FIPS mode for SSL 

• FIPS mode for SSH 

• HTTPS protocol 

• HTTPS settings 

• HTTP protocol 

• FTP Implicit Protocol 

• FTP Explicit Protocol 

• FTP protocol 

• Password 

• Password complexity 

• Password reset 

• Password expiration 

• Password History 

• Password initial reset 

• Invalid login settings 

• Inactive account 
settings 

• Account expiration 
settings 

• Connection limits 

• Transfer limits 

• Disk limits 

• File type limits 

• IP address ban list 

• Group assignment 

• Group (Permission) 

• Data sanitization 
(wiping) 

• SMTP settings 

• DoS prevention settings 

• Delegated 
Administrators 

• Server 

• Site 

• Settings Template 

• User Account 

• Real-time monitoring 

• User kicked 

• Web Services Interface 

• Site root folder 

• Site listening IP 

• Custom command 

• Event Rule 

• Physical folder 

• Virtual folder 

• Folder permissions 

• Administrator 

• Database refresh 
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• FTP settings 

• AS2 protocol 

• AS2 settings 

• PASV port mode 
settings 

• Streaming repository 
encryption (EFS) 

• OpenPGP settings 

• OpenPGP key 

• Web Transfer Client 

• DMZ Gateway 

• DMZ Gateway settings 

• Authentication settings 

• Remote administration 

• Auditing settings 

• Log settings 

• Default Configuration 
File Path 

• Default User Database 
Refresh Interval 

• Server service settings 

• Show Time In 
UTC/GMT 

• Ban On Invalid Login 
Settings 

• AWE Task 

• Account details 

  

Purging Data from the Database 

Space requirements for transactions in the ARM Database depend on the estimated EFT activity, number of 
users, and installed modules. A general estimate is 3MB to 5MB of per 1000 files uploaded. A minimum of 
3GB hard drive space is recommended for the initial database size, with additional space required for growth 
over time.  As your database continues to grow, it is necessary to purge old records periodically. 

For detailed information on purging the database, refer to Knowledgebase article #10426: How can I purge 
EFT data from my ARM database? 

Result IDs 

The ARM captures the following transaction information from EFT, which can appear in reports: 

Actions 

ResultI
D 

Description Result Const 

-1 If the Event Action is in progress empty 

0 If the Event Action is successfully 
executed 

EAR_SUCCESS 

1 If the Event Action fails EAR_FAIL 

2 If STOP Processing this rule is 
selected as Action. 

EAR_STOP_RULE 

4 If STOP processing more rules is 
selected as Action 

EAR_STOP_ALL 

  

 

Stop processing this rule and Stop processing more rules can be combined, in which case the value is the sum 
of the two individual values, that is, 6. 

https://kb.globalscape.com/KnowledgebaseArticle10426.aspx
https://kb.globalscape.com/KnowledgebaseArticle10426.aspx
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SocketConnection 

ResultI
D 

Description Result Const 

0 When socket successfully 
created 

ER_NONE 

8 Per Site socket connection limit 
exceeded 

ER_CONNECT_FAILED_TOO_MANY_CONNECTIONS_PER_SITE 

9 Max connections per IP address 
limit exceeded 

ER_CONNECT_FAILED_TOO_MANY_CONNECTIONS_PER_IP 

10 EFT denied the connection 
because the IP address was in the 
ban list or it is a remote IP 
address and EFT is in developer 
mode 

ER_CONNECT_FAILED_RESTRICTED_IP 

11 EFT denied the connection 
(failed) and added the IP address 
to the auto-ban list 

ER_CONNECT_FAILED_BANNED_IP 

Authentications 

ResultI
D 

Description Result Const 

0 Authentication successful LR_OK 

1 Incorrect password LR_PASSWORD_NOT_ACCEPTED 

2 If user account is disabled LR_ACCOUNT_DISABLED 

3 Max connections per Site limit 
exceeded 

LR_TOO_MANY_CONNECTIONS_PER_SITE 

4 Max connections per user 
limit exceeded 

LR_TOO_MANY_CONNECTIONS_PER_USER 

5 User per- IP address 
connection limit exceeded 

LR_TOO_MANY_CONNECTIONS_PER_IP 

6 If given protocol is not 
supported 

LR_PROTOCOL_NOT_SUPPORTED 

7 Connection on restricted IP 
address 

LR_RESTRICTED_IP 

8 If service is unavailable LR_SERVICE_UNAVAILABLE 

9 User is locked out   
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ClientOperations 

ResultI
D 

Description Result Const 

1 If copy/move/download 
operation is successful 

TRUE 

0 If copy/move/download 
operation fails 

FALSE 

CustomCommands 

ResultI
D 

Description Result Const 

0 Command executed 
successfully 

CER_OK 

1 Command executed with 
socket output 

CER_SYNC 

2 Access is denied CER_ACCESS_DENIED 

3 Command is not found CER_COMMAND_NOT_FOUND 

4 Could not launch the selected 
process 

CER_PROCESS_FAILED 

5 Command is disabled CER_COMMAND_DISABLED 

6 Errors in parameters passed to 
the custom command 

CER_ERROR_IN_PARAMS 

ProtocolCommands 

ProtocolCommands are the same as FTP result codes. Below is a brief general description. 

ResultI
D 

Description 

1xx Expected another reply before proceeding with a new command 

2xx Requested action completed successfully 

3xx On hold pending receipt of further information 

4xx Temporary failure 

5xx Permanent failure 

https://kb.globalscape.com/KnowledgebaseArticle10142.aspx
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Auditing Database Errors and Logging 

EFT detects errors that occur while trying to connect to the ARM database and can detect errors returned 
from the database while attempting to perform transactions. If an error is detected while connecting to the 
database or when performing a transaction on the database (SQL INSERT, UPDATE, etc.) you can configure 
EFT to log the error to a file and to send a notification to a specified e-mail address. 

By default, database errors are logged to \Logs\ in the format 
EFT_ARM_<YYYY_MM_DD_HH_MM_SS>.sql. (By default, C:\ProgramData\Globalscape\EFT Server 
Enterprise\Logs.) You can specify a different path or choose not to log the errors to a file.   

 

For details of the Log Settings area, refer to Log Settings. 

EFT also generates a Windows Event Log entry when there is an ARM database error. The log entry indicates 
whether auditing has stopped or if the auditing data is being stored to a log file. 

If database access is lost because of a connection error or transaction error (INSERT or UPDATE), 
resumption of auditing to the database requires a restart of EFT or a RECONNECT request by the 
administrator. If EFT is configured to stop auditing, the administrator must repair the database, and then 
restart EFT or use RECONNECT to resume auditing to the database. 

Logging to a Text File 

In the When a database error occurs area of the Server's Logs tab, you can configure EFT to log the SQL 
statements to a text file. EFT continues to use the text file until either EFT is restarted or until a 
RECONNECT request is made by the administrator. EFT then notifies you by e-mail that the logging has 
been saved to the text file. You can then repair the database, resume auditing to the database, and load the 
recorded text file SQL statements into the database. To ensure the completeness of the audit data, the SQL 
statements in the text file must be loaded into the database before executing reports over the time that SQL 
transactions were logged to the text file. 

If you click Reconnect to resume auditing to the database, and EFT is recording auditing information to the 
text file, EFT continues to log EFT file transfers and/or user sessions that are in progress to that text file. New 
file transfers and new user sessions will continue to be logged in the database, but any in-process 
transfers/user sessions are logged to the text file to ensure that they can be inserted and linked appropriately 
in the database. 

Refer to Audit Database Settings for information about configuring the connection information on EFT's 
Logs tab. 

Security Auditing 
Review the topics below for details of generating a daily PCI DSS Compliance report. 
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The Advanced Security and Express Security modules include the ability to audit EFT for compliance with the 
PCI DSS requirements. EFT scans all PCI DSS requirements addressed in EFT, and then reports on the 
compliance status of each requirement (Pass, Fail, or Warning). The report also provides a description of the 
requirement tested for each item. For failed requirements, the report presents a reason the non-compliant 
setting was used, if you provided one at the time that particular setting was disabled/changed. 

To generate the PCI DSS Compliance report 

• To generate the report in real time, do one of the following: 

o On the main menu, click Report > PCI DSS Compliance Report. A report is generated for 
each high security-enabled Site. 

o In the Site's Event Rule node, click Report Event. In the right pane, click Run Now. The 
report is e-mailed to the e-mail address defined in the Rule. 

• To generate the report on a recurring schedule, define a Scheduler Timer Event Rule  with the 
Generate Report Action. In the Event Rule, you can define whether to e-mail the report and/or save 
the report to a file. A report is generated specific to the Site on which the Event Rule is configured. 
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PCI DSS Possible Compliance Report Outcomes 

The PCI DSS Compliance Report displays the requirement name, status (PASSED, FAILED, WARNING), 
description of the requirement, notes that you typed in the Warning box (explanation, justification, or 
compensating control), report name, and date the report was generated, and description of the report. The 
report is grouped by and sorted by PCI DSS Requirement. 

If the report is generated after the trial has expired, the report contains a statement stating that the 
module has expired instead of the standard report. 

When in trial or after the module is activate, the report contains the following information: 

The status of audited PCI DSS requirements appears in the report. 

• 1.x – DMZ Gateway disabled or no connectivity 

• 2.x – Remote administrator enabled by not secure, vendor defaults in use, insecure protocols in use 
(FTP, HTTP) or insecure settings (NOOP and FXP), auto-ban/flood detection set too low or 
disabled, and login credential persistence enabled. 
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• 3.x – Disk quotas not present for limiting storage amounts, missing clean-up rule for data retention 
and disposal compliance. 

• 4.x – Weak cryptography in use (SSL version, cipher strength, manually specified ciphers, weak 
HMACs), insecure settings such as SSL clear command clear data channel in use. 

• 5.x – No checks 

• 6.x – No checks 

• 7.x – Presence of more than one full-control admin account 

• 8.x – Password length or complexity not enforced, password reuse allowed, idle session timeout 
disabled or set to high, inactive accounts not disabled or removed after 90 days, failed logins not 
resulting in account lockout after six (or less) attempts, password reset not allowed, password reset 
not forced on initial login, anonymous accounts present, and passwords not expiring after 90 days or 
sooner. 

• 9.x – Secure wiping of deleted data not enabled 

• 10.x – ARM not enabled or no connectivity 

• 11.x – No checks 

• 12.x – No checks 

Reporting 
The Auditing and Reporting module provides numerous predefined reports which you can use as is, edit to 
your needs, or use as templates to create new reports. You can also define custom reports using the built-in 
Report Designer. 

Descriptions of Preconfigured Reports 

The Auditing and Reporting module comes with a number of preconfigured reports that allow you to start 
analyzing data right away. The report templates are .xml files and are installed in 
%systemdrive%\ProgramData\Globalscape\EFT Server Enterprise\Reports or \EFT Server\Reports. If 
you plan to edit the default templates, it is a good idea to save a backup of them first. (Note: On Windows 
Server 2003 and earlier, the files are in ..\Documents and Settings\All Users\Application 
Data\Globalscape\EFT Enterprise\Reports or \EFT Server\Reports.) You can also use these reports as 
templates to create your own custom reports. 

The preconfigured reports fall into the following categories: 

• Billing: If you need to bill your customers for file transfer services and need to supply accurate 
reports to customers and for your own invoicing purposes, these reports allow you to query and 
produce reports based on multiple criteria such as a specific client, a group of clients or all clients, a 
particular date range, and a specific file or all files transferred for that user. 



45 

• Non-repudiation: If you need to audit transactions throughout their life cycle and determine 
whether a particular Event occurred and when it occurred, these reports allow you to search for all 
activity for a specific user for a specific date or to locate a transaction within a date range for auditing 
purposes, and allow you to show conclusively whether something happened, when it happened, and 
who was responsible for making it happen. 

• Statistics: Gathering statistical data allows you to take preventive measures (such as scale to meet 
increasing demand), to establish trends, create general usage reports for stakeholders, and to query 
and analyze trends and server usage (peak usage times, most active customers, etc.). 

• Technical troubleshooting: Granular auditing of all socket, protocol, authentication, and transaction 
information allows the administrator to quickly locate and solve problem scenarios. 

The preconfigured reports described below are provided with the Auditing and Reporting module. You can run 
the reports as is or edit them to suit your specific needs. 

• Activity - Ad Hoc (Detailed) - This report displays activity for ad hoc file transfer activity, sorted by 
date in reverse chronological order. If a user sent multiple files on one e-mail, each file is listed in the 
report.  

• Activity - Ad Hoc (Summary) - This report displays all ad hoc file transfer activity, grouped by 
username, and sorted by date in reverse chronological order. If a user sent multiple files on one e-
mail, each file is listed in the report.  

• Activity - Ad Hoc by File (Detailed) - This report displays all ad hoc file transfer activity for a 
specified file name, and sorted by date in reverse chronological order. If a user sent multiple files on 
one e-mail, each file is listed in the report.  

• Activity - Ad Hoc By Recipient (Detailed) - This report displays all ad hoc file transfer activity for 
a specified recipient's e-mail address, and sorted by date in reverse chronological order. If a user sent 
multiple files on one e-mail, each file is listed in the report. When you click Show Report, the Enter 
Report Parameters dialog box appears. Provide the entire e-mail address.  

• Activity - Ad Hoc by Sender (Detailed) - This report displays all ad hoc file transfer activity for a 
specified sender's e-mail address, and sorted by date in reverse chronological order. If a user sent 
multiple files on one e-mail, each file is listed in the report. When you click Show Report, the Enter 
Report Parameters dialog box appears. Provide the entire e-mail address. 

• Activity - All File Transfers - This report displays all file transfers as server, client, and LAN-copy 
event. Displays date and time, target path, account, direction, IP address, size in KB, code, and result 
(success/failure). 

• Activity - All File Transfers (as Server) - This report displays all file transfers as server. 

• Activity - All Groups (Detailed) - This report displays the various Actions performed by all the 
groups, such as Administrator, All users, and Guests, and it displays Date/Time, Remote IP address, 
protocol, Action, filename, folder, bytes transferred, and the result. 
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• Activity - All Users (Summary) - This report displays the transfer activity (total number of uploads 
and downloads) for all users who logged on to EFT during the date range specified, grouped by 
username, subgrouped by date, sorted by username, then transfer direction, and date, in ascending 
order. 

• Activity - All Users (Detailed) - This report displays all folders and files created and the delete 
activity for all users who logged on to EFT during a particular period, grouped by username, and 
sorted in reverse chronological order. The report includes the time stamp, remote IP address of the 
user, protocol, Action, file name, folder, KB transferred, and the result. 

• Activity - By File - This report displays all the activities related to a specified file, based on wildcard 
masks, grouped by Site name, subgrouped by matching filename, sorted in chronological order. The 
report displays the time stamp, user name, remote IP address, and protocol. To generate this report, 
you have to specify the report parameters, such as .txt to view only txt files or *.* to view all files. 

• Activity - By Group (Detailed) - This report displays the folder and file create and delete activity 
during a specified period for a specific group, grouped by group name, and sorted by date in reverse 
chronological order. The report displays the remote IP address, protocol, Action, time stamp, file 
name, folder, bytes transferred, and result. When you click Show Report, the Report Parameters 
dialog box appears asking for the group name. 

• Activity - By User (Detailed) - This report displays the folder and file create and delete activity 
during a specified period for a specific user, grouped by username, and sorted by date in reverse 
chronological order. When you click Show Report, the Report Parameters dialog box appears 
asking for the name of the user. 

• Activity - By User (Detailed) - Group by Username-Action - This report displays the folder and 
file create and delete activity during a specified period for specific users, grouped by username, 
subgrouped by Action, and sorted by date in reverse chronological order. That is, the report displays 
all files created under the Created Action and all files that are sent are displayed under the Sent 
Action. When you click Show Report, the Report Parameters dialog box appears asking for the 
name of the user. 

• Activity - By User (Summary) - This report displays the transfer activity for specifics users, 
grouped by username, subgrouped by date, sorted by username, transfer direction, and date, in 
descending order. 

• Admin Actions - (Requires EFT Enterprise, Advanced Security Module, and ARM) This report 
displays all EFT administrator activity for the specified range. Columns displayed in the report and 
available report filters include Date/Time (Timestamp), Function (e.g., User Account, Site, Database 
Refresh, SMTP Settings), Action (e.g., Created, Enabled, Disconnected, Modified, Started, 
Renamed), Affected Area (e.g., User Account, Site, Server, Administration), Affected Name 
(username), ChangeOriginator (administrator username), SiteName (e.g., MySite). 

• Admin Activity (Summary) - This report displays all administrative connections (successes and 
failures) to EFT. 
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• AS2 Transactions Detailed - A verbose AS2 file transfer report that provides the information 
necessary for troubleshooting problem transactions.  

• AS2 Transactions Overview - A transaction report that displays the same information as shown on 
the Transfers - AS2 node. The report queries all AS2 transactions for the dates specified, grouped 
by site, sorted by date, and listed in reverse chronological order. 

• Content Integrity Control - Actions (detailed) - A report showing all Event Rules with CIC 
actions, grouped by site name, sub-grouped by the user-defined event name, sorted by the unique 
event ID (not shown) in descending order. Includes Parameters, Begin and End Date\Time, and 
Result. 

• Event Rules - Actions (Summary) - This report summarizes all Event Rules with their 
corresponding Actions, grouped by Site name, subgrouped by the user-defined Event name, sorted 
by the unique Event ID (not shown in report) in descending order. 

• Event Rules - Activity (Detailed) - This report displays the Event Rule activity by user-defined 
Event name, grouped by Site name, subgrouped by the Event type, sorted by date in reverse 
chronological order. 

• Event Rules - Activity (Summary) - This report summarizes the Event Rule activity by user-
defined Event name, grouped by Site name, sub-grouped by the Event type, sorted by date in reverse 
chronological order. 

• Event Rules - Inbound-Outbound By Date - This report details all offload and download Actions, 
grouped by Site subgrouped by Action, sorted by date in reverse chronological order. 

• Event Rules - Inbound-Outbound By User - This report details all offload and download Actions, 
grouped by Site name, then by remote host IP address, then by username, sorted in reverse 
chronological order. 

• Executive Summary Report - This report summarizes the following information for the period 
specified: 

o Average transfer speed 

o Total number of downloads, uploads 

o Total bytes transferred (inbound/outbound) 

o Top 5 users (by # of connections) 

o Top 5 users (by bytes transferred) 

• Outlook Pick Up Report - This report details Outlook receiving activities, including receipt date, 
receipt email, sender email, file name, file size, Workspace name, and expiration date. 

• Outlook Send Report - This report details Outlook sending activities, including send date, owner, 
sender email, recipient email, file name, file size, Workspace name, and expiration date. 
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• Security - Failed Logins - This report displays the number of users who could not connect to EFT. It 
displays the user name, remote IP address, protocol used, date, time, remote IP address, port 
number, and result. 

• Traffic - Average Transfer Rates by User - This report displays the average transfer rate for 
specific users, grouped by username, subgrouped by date, sorted by username, transfer direction, and 
date, in descending order. 

• Traffic - Connections Summary - This report details connections to EFT (IP address or user 
connections) and bytes transferred by date, grouped by Site name, sorted by date in reverse 
chronological order. 

• Traffic - Datewise-Hourly Bytes Transferred - This report details the connections and bytes 
transferred sorted by date and hour, in chronological order. 

• Traffic - Datewise-IPwise bytes transferred - This report displays the connections established by 
remote IP addresses and total bytes transferred. 

• Traffic - IPwise Connections (Summary) - This report displays the connections established by 
remote IP addresses and total bytes transferred. 

• Traffic - Monthwise-IP-wise Bytes transferred - This report displays the connections established 
by various remote IP addresses each month. It displays the Site name, month name, remote IP 
address, connections, and total bytes transferred. 

• Traffic - Most Active IPs - Connections - This report displays the most active IP addresses; that is, 
the IP addresses of the users who frequently log on to EFT. It displays the data transferred, Site 
name, remote IP address, and bytes transferred. This report can be used to determine Denial of 
Service (DoS) attacks against EFT. 

• Traffic - Most Active IPs - Data Transferred - This report displays the IP addresses of users who 
log on to EFT frequently; the number of connections established by various users. It displays the 
information on the total bytes transferred, number of connections, remote IP address, and Site name. 

• Traffic - Most Active Users - Connections - This report displays the connections established by 
the most active users. 

• Traffic - Most Active Users - Data Transferred - This report displays the usernames of users who 
log on to EFT frequently, the number of connections established by various users, and number of 
bytes transferred. 

• Traffic - Protocolwise Connections (Summary) - This report displays the connections established 
by various users and the protocol used by the users to transfer the data, that is, whether the users 
have used FTP, HTTP, or any other protocol to upload or download the files. 

• Traffic - Sitewise-Hourly by User - This report displays the total number of connection established 
by various users on a particular Site each hour. 
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• Troubleshooting - Connection Errors - This report displays the number of connection errors 
occurred while connecting to a site. 

• Troubleshooting - Event Rules Failures - This report displays failures related to the Event Rules. 

• Troubleshooting - IP Address Activity (Detailed) - This report displays the details of the user, the 
date/Time on which the user logged on EFT; other details such as local port, socket result ID, 
protocol, password, physical folder name, virtual folder name, and so on are also displayed. To view 
this report, you must specify the IP address in the Enter Report Parameters dialog box that opens 
when you click Show Report. 

• Troubleshooting - Operation Errors - This report displays protocol error codes and corresponding 
commands, sorted in reverse chronological order. The report includes the date and time the error 
occurred, remote IP address, protocol used, username, command, filename, virtual folder, and result 
(e.g., transfer completed). 

• Web Service- Invoke Event Rules (Detailed) - This report is used to view activity for invoking 
Event Rules through Web Service, grouped by username, and sorted by date in reverse chronological 
order. 

• Workspaces Activity - Shows shared Workspaces invitation activity on EFT for a given period by 
Site. Displays date, Workspace name, path, owner, action, status, participant, and permission. 

Generating a Report 

The ARM comes with a number of preconfigured reports to help you start analyzing data right away. The 
built-in reports were designed to respond to the most common data analysis requests. Refer to Preconfigured 
Reports for a list of available reports. 

 

If you are using SQL Express as your database, you may not be able to generate a report remotely, unless the 
connecting account is a trusted SQL Server connection (i.e., if SQL Server and the remote computer are in the 
same domain, or if SQL Server is configured to allow "mixed authentication.") 

To generate a report 

1. In the administration interface, connect to EFT and the reports database, and then click the Reports 
tab. 

2. In the left pane, click the desired report. 

3. In the right pane, specify any filters. 

4. Specify a date range from which you want pull data. 

5. Type the appropriate parameters/wildcards for the search if the following reports are used: 

• Activity By File - Type the file name. 

• Activity By Group - Type the group name. 

• Troubleshooting IP address Activity - Type the IP address. 
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6. Click Show Report. The ARM connects to the auditing database and displays the data in the right 
pane. 

 

ARM displays the first page of the report as soon as the data is ready, then continues to load additional pages. You 
can monitor the progress of loading by watching the current page/total pages indicator on the report filter bar. 
 

 
 
If you want to stop a report from loading, click another report in the left pane. 

Using Report Filters 

You can filter the fields in a report based on various conditions to display only the data that meet the filtering 
criteria. 

The Report Filters area contains two sets of combo boxes, operands (AND, OR), and a text box. 

 
Use the second set of filters to further define the report using AND or OR. 
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For example, suppose you have generated a report like the one below: 

 
To show only changes made by TommyToad and June.Bug, set the following filters: 

1. In the first combo box, click Change Originator. 

2. In the second combo box, click the equals sign ( = ). 

3. Type June.Bug in the text box. 

4. Click OR. 

5. In the bottom filter, click Change Originator, equals, and type TommyToad. 

 
6. Specify a date range, and then click Show Report. 

7. The report now displays only changes made by administrators TommyToad or June.Bug. 
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(If you had clicked AND instead of OR, nothing would appear, because no changes can be made by 2 
administrators at the same time.) 

Defining Custom Reports 

The topics below provide information regarding creating custom reports of EFT activity in the administration 
interface. 

VSReport Designer 

Querying, sorting, filtering, and reporting on EFT data can be accomplished by editing one of the existing 
reports or creating a new report in the provided report editor. This tool can be launched from within the 
administration interface.   

The report editor tool bundled with ARM is a robust report designer licensed from Component One. During 
EFT evaluation period, VSReport Designer is available for use as a fully functional 30-day trial. A license for 
VSReport Designer is included with each purchase of ARM. After the 30-day trial, ARM must be activated 
along with EFT to continue using VSReport Designer. Most of the main functions of the report designer are 
described in this help file; however, the VSReport Designer has its own Help file, accessed by clicking Help on 
the report designer's main menu. 

In VSReport Designer, you can work on existing report templates, change field locations and properties, add 
various levels of grouping, sorting, and so on. You can also create new reports and select ARM’s database 
tables from which to retrieve data fields or paste in SQL code for advanced queries of the data source, giving 
customers complete freedom in designing their report. Styles for the report (colors, fonts, background logo 
images, etc.) can all be manipulated from within the designer. You can also import report definitions from 
Microsoft Access files (MDB, ADP) and VSReport Designer files (VSR) from within the Report Designer. 

 

Translation of Access reports requires that Microsoft Access is installed. Once the report is imported into the 
Designer, Access is no longer required. 
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The main Designer dialog box includes the following: 

• Report list - The left pane of the Report Designer lists all report templates contained in the current 
report definition file. (A report can contain multiple report templates.) You can double-click a report 
name to preview or edit the report. You can also right-click in the list to rename, copy, and delete 
report templates. 

• Preview/Design pane - The right pane is the main working area of VSReport Designer. In preview 
mode, it displays the current report. In design mode, it shows the report's sections and fields and 
allows you to change the report definition. 

• Main Menu - The main menu is used to access submenus, load and save report definition files, import 
report definitions, and print reports. 
 

 
• Shortcut toolbar - Shortcuts are used to access the most common menu functions: new file, open, 

import, save, print, undo/redo, cut/copy/paste, create/delete report, and help. 
 

 

• View toolbar - The View toolbar allows you to easily switch between preview and design modes, 
activate the design grid, and display the property and grouping panes. 
 

 

• Toolbox - The Toolbox provides tools for creating report fields. This toolbar is enabled only in design 
mode. 
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• Formatting toolbar - The Formatting toolbar provides shortcuts to tools for aligning, sizing, and 
spacing report fields. This toolbar is enabled only in design mode. 
 

 
• Status bar - The Status bar at the bottom of the Report Designer displays information about what 

VSReport Designer is working on (e.g., loading, saving, printing, rendering, importing, etc.). 
 

 
Opening VSReport Designer 

When you create a new report, you create it manually or use the Report Wizard. Both methods are provided 
in the VSReport Designer, as described below. 

To open VSReport Designer 

1. In the administration interface, connect to EFT, then do one of the following: 

• On the toolbar, click the click New Report icon . 

• On the main menu, click Reports > New Report. 

• Click the Reports tab, and then click the New Report icon at the bottom of the right pane. 

The New Report dialog box appears. 
 

 
2. Type a title for the new report, and then click Create. The Report Designer appears. 
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3. Do one of the following to create a report: 

• Manually define the report: click the report name in the left pane, click the Design icon 
, then continue with the instructions in Using Design Mode, Changing Field, Section, and 
Report Properties, Changing the Data Source, Adding, Editing, and Deleting Fields in the 
Report, and Grouping and Sorting Data. 

• Use the Report Wizard: In the Report Designer, click File > New Report or click the New 
Report  icon on the toolbar. 

Creating a Report with the Report Wizard 

The easiest way to start a new report is to use the Report Wizard. The Report Wizard will help you create a 
basic report, specify the data source, fields to include in the report, layout of the report, and styles or labels to 
use in the report. 

To use the Report Wizard 

1. In the administration interface, connect to EFT, then do one of the following: 

• On the toolbar, click the click New Report icon . 

• On the main menu, click Reports > New Report. 

• Click the Reports tab, and then click the New Reports icon on the bottom toolbar. 

The New Report dialog box appears. 

 
2. Type a title for the new report, and then click Create. The Report Designer appears. 
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3. Click File > New Report or click the New Report   icon on the toolbar. The New Report Wizard 
appears. 

 
4. By default, the ConnectionString box displays information for the database that you specified when 

you installed the Auditing and Reporting module. Click Next and go to step 5 or, if necessary, you 
can type a different string that is used to connect to the data source. 

a. Click the ellipsis to define the connection string. The Data Link Properties dialog box 
appears. 

b. On the Provider tab, click Microsoft OLE DB Provider for SQL Server as the provider to 
connect to the SQL Server database, and then click Next. The Connection tab appears. 

c. In Select or enter a server name, click the arrow to select a name or type the name of EFT. 

d. In Enter information to log on to EFT, click an authentication option to log on to EFT: 

• Use Windows NT Integrated security - Your computer automatically picks up the 
credentials from your computer and connects you to the database. 

• Use a specific user name and password - Specify the user name and the password 
to be used to log on to EFT. Select the Allow saving password check box to save 
the password in the connection string. 

 

Select the Blank password check box if EFT requires a blank password to log on the 
database server. Even if you do not type any password when you create a user account 
on a database server, you can select the Allow saving password check box. In this case, 
EFT takes a dummy password value and saves that value in the connection string. 
Selecting the Blank password check box disables the password field. 

e. Click one of the following: 

• Select the database on EFT, and then click a database in the list. 
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• Attach a database file as a database name - Click the ellipsis icon  to browse for 
the SQL Server database file (*.mdf). The Select SQL Server Database File dialog 
box appears. Select a file, then click Open. The path to the file appears in the Using 
the filename box. 

f. Click OK in the Data Link Properties dialog box to return to the New Report Wizard. 

4. Click one of the following: 

o Table to select a database table, such as tbl_EventRules. 

o SQL Statement to type a SQL query in the bottom box, such as SELECT * FROM 
tbl_EventRules. 

5. Click Next. The fields that appear in the Available list depend on your selection in the previous step. 
For example, if you selected tbl_EventRules, the fields for Event Rules appear. 

 
6. Double-click a field, click it and use the arrows, or drag and drop one or more field to the Groups list. 

Group fields define how the data is sorted and summarized. The information in the Detail list is 
grouped according to the group name. The Detail list displays the details for each group. Detail fields 
define the information you want to appear in the report. For example, if you move SiteName to the 
Groups list and Time_stamp, EventName, and so on to the Detail list, then the report displays the 
time stamp and events under the respective Sites, considering different Sites as different groups. 

 

You can also drag and drop the available fields into the Groups or Detail section. 

7. Click Next. The layout options appear. 
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8. Click a layout for the report. When you select a layout, a thumbnail preview appears on the left to give 

you an idea of how the layout will appear on the page. There are two groups of layouts. The first is for 
the reports with no groups defined and other is for the reports with group fields defined. 

• If you did not define the Group field, the following options are available: 

 Columnar 

 Tabular 

 Justified 

 Labels. The Labels layout option is used to print Avery-style labels, available in a 
variety of sizes, blank or preprinted. If you select this option, the next page offers 
options for the type of label for your report. 

• If you defined the Group field, the following options are available: 

 Stepped 

 Outline 

 Aligned 

9. If you selected any option other than Labels, click the report orientation from the following options. If 
you select the Labels option, the Orientation options are disabled. 

• Portrait 

• Landscape 

10. Select the Adjust fields to fit page check box to adjust fields in a way that they fit the page. 

11. Click Next. 

12. Do one of the following: 
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• If you specified Labels, click a type of label in the Labels list, then specify the Units, Metric 
or English, and the paper type, Sheet Feed (single sheet) or Continuous (continuous 
paper). 

 
• If you specified anything other than Labels, specify a style for the report title. 

 
13. Click Next. The title page of the wizard appears.  
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14. Type a title for the report. 

15. Do one of the following: 

• To view the report, click the Preview the report. 

• To modify the report in Design view, click the Modify the report's design. 

16. Click Finish. Your new report name appears in the left pane of the Report Designer. The right pane 
displays a preview of the report or the design view, depending on your selection in the previous step. 

17. Click Save to save the report. 

18. Click File > Close to close VSReport Designer. The report appears on the Reports tab. 

19. Use Design mode to add/remove fields, resize fields, add graphics, and so on. 

Creating a Report in Design Mode 

The New Report Wizard is used to specify a data source and a basic framework for the report. To get exactly 
the report you want, you can adjust and enhance the data fields and layout. The Report Designer provides the 
options to modify the report to fit your needs. 

To use the Report Designer design mode 

1. In the administration interface, click the Reports tab, then do one of the following: 

• Click the report that you want to modify, and then click Edit Report. 

• Create a new report. (Refer to Creating a Report with the Report Wizard for instructions.) 

The report appears in the Report Designer. 
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2. The left pane of the Report Designer lists all report templates contained in the current report 
definition file. Click the report that you want to modify, and then click the Design  icon on the 
View toolbar, or on the main menu, click View > Design. The right pane switches from Review mode 
to Design mode, and displays the controls and fields that make up the report. 
 

 
The Report Sections 

The report is divided into sections, labeled Header, Page Header, Detail, and Page Footer, containing fields 
that hold the labels, variables, and expressions that you want in the generated report. The sections determine 
the appearance of the beginning and end of the report, and each page and group. The table below describes 
where each section appears in the report and the sort of data that typically appears in each section. 

Section Appears Typically Contains 

Report Header Once per report The report title and summary information for the whole report 

Page Header Once per page Labels that describe detail fields and/or page numbers 

Group Header Once per group 
Fields that identify the current group and possibly aggregate values for 
the group (e.g. total, percentage of the grand total) 

Detail Once per record Fields containing data from the source record set 

Group Footer Once per group Aggregate values for the group 

Page Footer Once per page Page number, page count, date printed, report name 

Report Footer Once per report Summary information for the entire report 

You cannot directly add and delete sections. The number of groups determines the number of sections in a 
report. Each report has exactly five fixed sections (Report Header/Footer, Page Header/Footer, and Detail) 
plus two sections per group (a Header and a Footer). 
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To hide sections that you do not want to display 

1. Right-click the field, click Properties. The Field Properties dialog box appears. 

2. Change the property of Visible to False. 

To resize a section 

1. Click and hold the border of the section and drag it to the position where you want it. 
The rulers on the left and on top of the design dialog box show the size of each section (excluding the 
page margins). You cannot make the section smaller than the height and width required to contain 
the fields in it. To reduce the size of a section beyond that, move or resize the fields in the section 
first, then resize the section. 

2. Press and hold SHIFT, and then click fields to toggle their selection status. 

3. Press and hold CTRL, then drag the cursor to copy a selection. 

4. Click on the corners of a field to resize it. 

5. Press TAB to move the selection to the next field. 

6. Press the arrow keys to move selected fields. 

7. Press DELETE to remove selected fields. 

 

If you make any mistakes while moving or editing the fields, click Undo and/or Redo. 

When multiple fields are selected, you can use the buttons on the Format toolbar to align, resize, and space 
them. 

 
You can control the design grid using the Show Grid and Snap To Grid icons. 

Changing Field, Section, and Report Properties 

You can view and edit the properties of the objects inserted in a report. 

• When more than one field is selected, the Field Properties dialog box displays only the properties 
and values that all selected fields have in common and leaves the other properties blank. 

• If no fields are selected and you click a section (or on the bar above a section), the selected section's 
properties are displayed. 

• If you click the gray area in the background, the Report properties are displayed. 

To view and edit an object's properties 

• Double-click the object or select the object, then do one of the following: 

o Click Property Window. 

o Press F4 
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o Right-click, and then click Properties. 

The Field Properties dialog box appears. 

In the example below, the Activity - All Group (Detailed) label in the Header section is selected. The Field 
Properties dialog box displays the properties of the selected field. 

 
In the Field Properties dialog box, you can change a property by changing its value. For example, you can 
change the text color by changing the ForeColor property. You can change the field's position and 
dimensions by typing new values for the Left, Top, Width, and Height properties. 

The property dialog box expresses all measurements in twips (the native unit used by the ComponentOne 
report designer), but you can type in values in other units and they will be automatically converted into twips. 
For example, if you set the field's Height property to "0.5in," the property dialog box will convert it into 720 
twips. 

Adding, Editing, and Deleting Fields in the Report 

VSReport Designer only has one type of field object; the icons in the Toolbox simply set the properties of the 
field to make it look and act in a certain way. 

To add, edit, or delete fields in a report 

1. In the Report Designer, click View > Design or click the Design icon   on the toolbar. The report 
opens in the design mode. 

2. Use the ToolBox to add fields to your report. Follow the procedures below depending on the fields 
that you want to add, edit, or delete. 
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Each icon creates a field and initializes the field's properties as follows: 

Ico
n 

Name Description 

 

Label field Creates a field that displays static text. 

 

Bound field Creates a field that is bound to the source recordset. When you click this 
button, a menu appears and you can select the recordset field. Bound Fields 
are not limited to displaying raw data from the database. You can edit their 
Text property and use any VBScript expression. 

 

Expression Field Creates a calculated field. When you click this button, the code editor dialog 
will appear so you can enter the VBScript expression whose value you want to 
display. 

 

Check box Field Creates a bound field that displays a Boolean value as a check box. By default, 
the check box displays a regular check mark. You can change it into a radio 
button or cross mark by changing the value of the field's Checkbox property 
after it has been created. 

 

Unbound Picture field Creates a field that displays a static picture, such as a logo. When you click 
this button, a dialog box will appear to prompt you for a picture file to insert in 
the report. A copy is made of the picture you select and is placed in the same 
directory as the report file. You must distribute this file with the application 
unless you embed the report file in the application. When you embed a report 
file in your application, any unbound picture files are embedded too. 

 

Bound Picture field Creates a field that displays a picture (or object) stored in the recordset. 
When you click this button, a menu appears so you can select a picture field 
in the source recordset (if there is one; not all recordsets contain this type of 
field). 

 

Line field Creates a line. Lines are often used as separators. 

 

Rectangle field Creates a rectangle. Rectangles are often used to highlight groups of fields or 
to create tables and grids. 

 

Subreport field Creates a field that displays another report. When you click this button, a 
menu appears and you can select other reports that are contained in the 
same report definition file. 

 

Page Break field Creates a field that inserts a page break. 

After you click any of these icons, drag the mouse over the report and the cursor will change into a crosshair. 
Click and drag to define a space that the new field will occupy, and then release the button to create the new 
field. If you change your mind, press ESC or click the arrow button to cancel the operation. 

You can also add fields by copying and pasting existing fields, or by holding down the control key and dragging 
a field or group of fields to a new position to create a copy. 
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To draw a line 

• Click Line , then drag the cursor where you want to draw a line. 

To draw a rectangle 

• Click Rectangle , then drag the cursor where you want to draw a rectangle. 

To add or edit text 

1. Insert a rectangle, or double-click or right-click an existing rectangle, and then click Properties. The 
Field Properties dialog box appears. 

2. Scroll to Text in the Property column, click the Value 
column, then type the text; press ENTER. 

To add labels 

• Click Label , then drag the pointer to draw a box in 
the report at the place you want to add a label. Name the 
label, then specify its font, color, and other properties. 
You can click and drag the label to adjust its placement in 
the report. 

To add data fields 

• Click Data field , then draw a box on the report. 
Change the properties of the data field by right-clicking 
it, and then clicking Properties. 

 

To create a VBScript expression 

1. Click Calculated field  on the toolbar. The VBScript 
Editor appears. 

2. Type the VBScript expression. For example, type: 

=count (Transaction ID) 

3. Click OK. 
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4. Drag the pointer and place it under the respective field where you want the result to display. 

5. Click the Preview icon on the toolbar 
to view the result. 

 

 

 

 

 

To insert images 

1. Click Picture . The Open dialog box 
appears. 

2. Click an image, and then click Open. 

3. Drag the cursor to draw a box where you want the image to appear. 

To delete fields 

• Click the field, then press DELETE. 

 

Changing the Data Source 

The data source is defined when you installed the 
ARM database. If you have more than one data source 
available, you can specify a different source.   

To change the data source for a report 

1. View the report in Design mode . 

2. Click the DataSource icon. The wizard 
appears. 

• The title bar displays the name of the 
report. 

• The ConnectionString box is 
populated with the string that was defined when you installed ARM  

e.g.: 

"provider=sqloledb;server=K2003VM\GLOBALSCAPE;database=EFTDB;Trusted_Connection=yes;" 

• The box below the ConnectionString displays the table or SQL Statement used to populate 
the report. 
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3. To specify a different data source, click the browse icon 
. The Data Link Properties dialog box appears. 

4. In the OLE DB Provider(s) list, click the data source 
server (e.g., Microsoft OLE DB Provider for SQL 
Server), and then click Next. The Connection tab 
appears. 

5. In the Select or enter a server name box, click the 
down arrow, and then click the database host\instance 
name. If the server you want does not appear in the list, 
click Refresh. (If you still do not see the ARM database 
server, verify EFT's connection to the database on the 
Server's Logs tab.) 

6. In the Enter information to log on to the server area, 
do one of the following: 

• Click use Windows NT Integrated security. 
The system will use the logged-in user's account for database connections. 

• Click Use a specific user name and password, then specify the username and password. 

7. In the Select the database on the server box, click the down arrow and select the ARM database 
name. 

8. Click OK. The wizard displays the data from the specified source. 

9. Click OK to close the data source wizard. 
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Grouping and Sorting Data 

After designing the basic layout, you may decide to group the records by certain fields or other criteria to 
make the report easier to read. Grouping allows you to separate groups of records visually and display 
introductory and summary data for each group. The group break is based on a grouping expression. This 
expression is usually based on one or more recordset fields, but it can be as complex as you like. 

Groups are also used for sorting the data, even if you do not plan to show the Group Header and Footer 
sections. 

The bar across the top of each section (Page Header, Group Header, Detail) contains some useful tools and 
information about the section. 

 
The indented box with a minus sign  or a plus sign  to the left of the section is used to collapse and expand 
the section. This feature is useful when you are designing the report to allow you to see a group's header and 
footer on the same screen without scrolling. Collapsing or expanding a section has no effect on how it is 
rendered in the report. 

• An indented circle  indicates that the section currently has zero height. You can drag the divider 
line down to increase the section's Height property. 

• The triangle  to the left of Group Header indicates the group's sorting order. You can click this icon 
to open the Sorting and Grouping dialog box. 

• The labels to the right of the icons are the section name and, for group headers, the value of the 
group's GroupBy property (in this example, Country). 

To add, edit, reorder, or delete groups in the report 

1. Click the Sorting and Grouping icon , click View > Grouping Window, or click the triangle  to 
the left of the group header. The Sorting and Grouping dialog box appears. 
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2. Use this dialog box to create, edit, reorder, and delete groups. 
 

 
To create a new grouping condition 

1. In the Group On column, click an empty row and type a name. For complex grouping, type an 
expression instead of a simple field name. For example, you could use "Country" to group by country 
or "Left(Country, 1)" to group by country initial. 

2. In the Sort column, click the arrow to select the sort order you want to use for grouping the data 
(Ascending, Descending, or None). 

3. In the Header, Footer, and Keep Together columns, specify whether the new group will have visible 
Header and Footer sections, and whether the group should be rendered together (No, With first 
detail, or Whole Group) on a page. 

 

You cannot use memo or binary (object) fields for grouping and sorting. This is a limitation 
imposed by OLEDB. 

4. After you enter some data for the first group, a new blank row is appended to the list, so you can keep 
creating new groups. If you add more groups, you can change their order by clicking on the left-most 
gray cell in the row and dragging the row to a new position. This will automatically adjust the position 
of the Group Header and Footer sections in the report. 

5. To delete a field in the group, select it, then press DELETE. 

6. Click OK. The changes appear in the Designer. 

Example: Creating a Custom Report 

Below is an example of using the Report Wizard to create a custom Administrator Actions report sorted by 
Site Name. The example assumes you have installed ARM with SQL Server Express and have performed 
administrator actions in EFT, such as creating users, stopping/starting sites, and so on. (The ASM is required 
for administrator actions reporting.) 
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To create the report 

1. In the administration interface, connect to EFT, click the Site on which you want to create the report, 
then do one of the following: 

• On the toolbar, click the click New Reports icon . 

• On the main menu, click Reports > New Report. 

• Click the Reports tab, and then click the New Report icon on the bottom 
toolbar. 

The Create New Report dialog box appears. 

2. Type a title for the new report, and then click Create. The Report Designer appears. 

So far, all you have done is opened the VSReport Designer, which allows you to open the New 
Report Wizard, which we will do next. You will delete this "template" later. 

3. Click File > New Report or click the New Report  icon on the VSReport Designer toolbar. The 
New Report Wizard appears. 

 

4. By default, the ConnectionString box 
displays information for the database 
that you specified when you installed 
the Auditing and Reporting module 
e.g.: 

provider=SQLNCLI10;server=localhost\GLOBALSCAPE;database=EFTDB;Trusted_Connect
ion=yes; 

 

5. Click Next and go to step 5 or, if necessary, you can type a different string that is used to connect to 
the data source: 

a. Click the ellipsis to define the connection string. The Data Link Properties dialog box 
appears. 

b. On the Provider tab, click Microsoft OLE DB Provider for SQL Server as the provider to 
connect to the SQL Server database, and then click Next. The Connection tab appears. 

c. In Select or enter a server name, click the arrow to select or type the name of EFT. 

d. In Enter information to log on to EFT, click an authentication option to log on to EFT: 
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• Use Windows NT Integrated security - Your computer automatically picks up the 
credentials from your computer and connects you to the database. 

• Use a specific user name and password - Specify the user name and the password 
to be used to log on to EFT. Select the Allow saving password check box to save 
the password in the connection string. 

 

Select the Blank password check box if EFT requires a blank password to log on the database server. Even if you 
do not type any password when you create a user account on a database server, you can select the Allow saving 
password check box. In this case, EFT takes a dummy password value and saves that value in the connection 
string. Selecting the Blank password check box disables the password field. 

e. Click one of the following: 

• Select the database on EFT, and then click a database in the list. 

• Attach a database file as a database name - Click the ellipsis icon  to browse for 
the SQL Server database file (*.mdf). The Select SQL Server Database File dialog 
box appears. Select a file, then click Open. The path to the file appears in the Using 
the filename box. 

f. Click OK in the Data Link Properties dialog box to return to the New Report Wizard. 

4. Click Table, then click tbl_AdminActions. 

5. Click Next. The fields that appear in the Available list are from the table you selected in the previous 
step. 
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6. Click and drag SiteName to the Groups field, 
then click and drag each of the other fields, 
except ID and TransactionID, into the Detail 
box. (If you click the right-facing arrows, every 
field will move to the Detail area. Then you can 
individually move back the fields you do not 
want.) 

 

7. Click Next. The layout options appear. 

8. Keep the default settings and click Next on 
each wizard page until you get to the last step. 
(For details of using the report wizard to define layout options, refer to Creating a Report with the 
Report Wizard. For this example, we used the default options.) 

 

9. Type a title for the report, and then click Finish. 

• The left pane of the Report Designer 
displays the report's name (and the 
report template that was created in 
step 2). 

• The right pane displays a preview of the 
report. 

• The title bar displays the name of the 
report and an asterisk, indicating that 
you have not yet saved the report. 

10. Let's get rid of that "new" template that was created when you opened the VSReport Designer. In the 
left pane, click the name of the template you want to remove, and then click the delete icon  on the 
toolbar. Click OK to dismiss the warning message. 

11. Click File > Save or click the Save icon on the toolbar. 

12. Click File > Exit to close VSReport Designer. 

13. On the Reports tab, expand the Custom Reports node. The new report appears in the tree. 

14. In the Custom Reports node, click to select the new report. 

15. In the right pane, click Show Report. The report appears in the preview pane. 
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You can filter the results, such as show results only for certain Sites, a specific administrator account, 
or a certain date. 

16. Click Save As to save the report. The report displays EFT administrator actions sorted by Site Name 
and Server. 
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Managing Reports 

The topics below provide information regarding managing the reports of EFT activity. 

Saving a Report 

You can save reports to a file and export them in the following formats: HTML (.htm), VSPrinter (.vp), 
Portable Document Format (.pdf), Rich-Text Format (RTF), or plain text (.txt). (See Exporting and 
Publishing Reports in the Report Designer for a description of the various formats.) 

To export a report 

1. In the administration interface, connect to EFT and the reports database, and click the Report tab. 

2. With the report displayed in the right pane, click Save As. 

3. In the Save as dialog box, specify the format and location to save the report, then click Save. 

Exporting Reports in XML Format 

You can save (export) EFT reports in XML format, and they can be imported in that format. 

To export the report 

1. In the administration interface, connect to EFT and click the Report tab. 

2. In the left pane, click the report. 
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3. On the main menu, click Reports > Export Report or right-click the report and click Export 
Report. The Save As dialog box appears. 

4. Specify a name (if you want to save it with a different name), location to save the report, and the file 
type to save it as (XML), and then click Save. 

Exporting and Publishing Reports in the Report Designer 

Instead of printing the report, you may want to export it into a file and distribute it electronically to your 
clients or coworkers. VSReport Designer supports several export formats, listed below: 

Format Description 

Paged HTML 
Creates one HTML file for each page in the report. The HTML pages contain links that let the 
user navigate the report. 

Drill-Down 
HTML 

Creates a single HTML file with sections that can be collapsed and expanded by the user by 
clicking on them. 

Plain MILT Creates a single, plain HTML file. 

PDF 
Creates a PDF file that can be viewed on any computer equipped with Adobe's Acrobat viewer 
or browser plug-ins. 

VSPrinter 
Creates a file using the VSPrinter control's native format. The file can be loaded, viewed, and 
printed from a VSPrinter control within an application or Web page. 

Text Creates a plain text file. 

To create an export file 

1. In the administration interface, connect to EFT and click the Report tab. 

2. In the left pane, click the desired report. 

3. In the right pane, click Edit Report . The report opens in the Report Designer. 

4. In the left pane of the Report Designer, click the report that you want to export. 

5. Click File > Export. The Save As dialog box appears. 
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6. Specify the type of file you want to create, its name (if you want to give it a different name), and its 

location, then click Save. 

Importing Reports 

You can add reports to EFT by importing the XML reports from the local drive to EFT. 

To import reports into EFT 

1. In the administration interface, 
connect to EFT and click the 
Report tab. 

2. On the main menu, click 
Report > Import or right-click 
the Reports node and click 
Import Report from the 
shortcut menu. The Open 
dialog box appears. 

3. Click the XML file you want to 
import, and then click Open. 

4. The report is added in the left 
pane under Reports. 
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Deleting a Report 

You can delete any reports that you no longer use. You cannot recover the report unless you previously 
exported and saved it. 

To delete reports 

1. In the administration interface, connect to EFT and click the Report tab. 

2. In the left pane, click the report, then do one of the following: 

• On the main menu, click Reports > Delete Report. 

• Right-click the report and click Delete Report. 

• Click Remove . 

A confirmation message appears. 

3. Click Yes to delete the report. The selected report is deleted and is not recoverable. 

Saving Report Outputs 

The report can be saved HTML, PDF, and XML. 

To save reports in different formats 

1. In the administration interface, 
connect to EFT and click the 
Report tab. 

2. In the left pane, click the report, 
then do one of the following: 

• On the main menu, click 
Reports > Save Report 
As. 

• Right-click the report, 
and then click Save 
Report Output As. 

The Save As dialog box appears. 
 
 

3. Navigate to the folder in which you want to save the report. 

4. In the File name box, type a name for the report. 

5. In the Save as type box, click a format, and then click Save. 
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Renaming a Report 

You can rename the preconfigured reports and your custom reports, but you can't just type a new name in the 
tree. You have to open the Report Designer to rename the report. 

To rename a report 

1. In the administration interface, connect to EFT and click the Reports tab. 

2. Click the report you want to rename, then click Edit Report . The report designer appears. 

 
3. In the left pane of the report designer, click the report name to make it editable, type your changes, 

then press ENTER or click away from the edit box. 

4. On the toolbar, click the Save icon , then close the Report Designer. 

 

The new name does not immediately update in the Reports tree of the administration interface. If you 
click or double-click the report in the tree, the name will update. 
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